
 
CALL FOR PAPERS  

SOUTH DAKOTA ACADEMY OF SCIENCE  
2021 ANNUAL MEETING  

 
The 2021 Annual Meeting of the South Dakota Academy of Science will be held virtually on October 
30, 2021.  Both posters and oral presentations will be shared via Gather Town.  The directions for 
submitting a poster or an oral presentation are found in the attachments.  All presenters, poster and 
oral, and attendees are required to be members of the SD Academy of Science and to register for the 
meeting.  Annual membership dues are $25.00, and the meeting registration fee is $10.00.  A Meeting 
Registration form has been attached to this email. and may also be found on the Academy website—
www.sdaos.org.    
To start the process, you will need to complete one Proceedings Submission Form (attachment) for each 
presentation and email it to Robert Tatina at rotatina@dwu.edu by October 15, 2021.   Only abstracts of 
posters and oral presentations will be published in the 2021 Proceedings (at an estimated cost of $20.00 
per page charged to the corresponding author).  Instructions for the style and format of the abstract are 
found at www.sdaos.org.    
Information about what and how to submit a poster or an oral presentation in Gathertown is given 
below (Guide to Oral Presentations and Guide to Posters in Gathertown). Those posters and oral 
presentations are to be sent to David Bergman (Dave.bergmann@bhsu.edu) no later than October 
22.  Early the following week you will be notified about specific times and locations for your poster/oral 
presentation.   
 

See you at the Annual Meeting! 
  

mailto:rotatina@dwu.edu
http://www.sdaos.org/
mailto:Dave.bergmann@bhsu.edu


Guide to Oral Presentations 
(Adapted from:  Carleton Cognitive Science Graduate Conference 2021)  

  

All of the 2021 South Dakota Academy of Science Annual Meeting will take place in 
gather.town.  You will be able to control an avatar and interact with others by text or audio and 
video when you are near other avatars (see general guide to gather.town (guide to Gather 
town).  Below, we will explain how to deliver your oral presentation in the Keynote Room of our 
Gather Town meeting.  

  

Getting started  

Presentation software: 

You can use the presentation software that you are most comfortable with; eg. PowerPoint or 

Keynote.  Oral presentations should be no more than 15 minutes in length, with an additional 

3-4 minutes allotted for questions.  After registering for the meeting (sdaos.org), you will be 

sent a link and a password that will give you access to the meeting. 

 

1. Click on the link sent to you.  

2. You will then be directed to Gather.town and asked to enter in a password.  This 

password should be emailed to you in advance of the conference.   

3. Enter in your name.  It is recommended to use your first and last name so that your 

colleagues will be able to identify you.  

4. A pop-up notification will require you to select your preferred audio and video devices.  

Once in gather.town, you will be able to mute your audio or stop your video using the 

icons by your video in the bottom right corner.  

  
5. Click on “Join the Gathering!” once you are ready to enter the meeting.    

https://carleton.ca/cognitivescience/wp-content/uploads/Guide-to-Gather.pdf
https://carleton.ca/cognitivescience/wp-content/uploads/Guide-to-Gather.pdf
https://sdaos.org/


6. Once you have joined, click on your name (located at the bottom of the screen).  Now 

you will be able to “Add text status”.  Enter in your affiliation here (ex: Carleton 

University).  

 

 
3. Calendar icon.  Ignore this.  

4. Chat icon.  Can chat globally to everyone, or to those nearby.  Can also select individual 

participants.  

5. List of all the participants.  Can access this to find a specific participant.  Then click on 

their name to see more options (chat, follow, locate).  

6. You will see the list of participants here, or chats, depending on what option tab you are 

on.  

  
  

Screen layout   

  

1.   Settings icon.   
2.   Build   icon.    Ignore this.   



7. Settings bar.  

8. Your video.  You can toggle your video and audio here.  

  
Settings Bar  

There is a settings bar located at the bottom of the screen.    
  

 
  

(1) You can use this to change the appearance of your avatar.  

(2) This allows you to view your location on the map.    

(3) This will let you use other interactions (clap, raise hand, etc.)  

  

Navigating: 

Moving and entering spaces  

You can move your avatar around using the arrow keys on your keyboard.  If you want 

to enter rooms, you can simply walk through the opening.  

 

Private Spaces  

Shaded squares are known as “private spaces”.  Your audio and video will be shared 
with everyone in these spaces, but no one else. Otherwise, your audio and video will be shared 
with those close by.  

Ghost Mode  

You can use ghost mode by holding down “g” on your keyboard.  Ghost mode allows 
you to pass through other avatars.  It will also hide all video and audio feeds, so you will not be 

seen and you will not see or hear others. Interacting  

1. You can interact with others by walking close to their avatar.  Their audio and video will 

automatically connect.  

2. You also have the option of viewing a full screen grid of the videos of those you are 

chatting with.  Simply click on the double arrow located beneath the thumbnail at the 

top of your screen.  

3. You can send a message to a specific individual by clicking on their name in the left-side 

column.  



4. You can choose to send a text-chat to everyone, people nearby, or specific individuals. 

You can also choose to “locate on map” a specific participant.  This will make a 

highlighted path that you can follow to get to them.    

5. Choosing “follow” will allow your character to follow a specific participant around.  This 

way, if you are walking around a room together, you will not risk cutting out with 

audio/video.  

  

The Rooms  

Lobby  

You will initially appear in the Lobby.  There is an information desk that will have a 
schedule for the day and a map of the virtual conference space. Move up from the 
Lobby to enter the Main Room.  

Main Room  

This is the first room from the Lobby.  It leads to the keynote room, the breakout rooms, 
the poster room, and the lounge.  There are some private spaces located within for 
smaller discussions as well.  

 

Keynote Room (oral presentations): 

 

 

This is where all the oral presentations will be located.  There may only be one keynote 
room, or if there are a lot of presentations, we may have two.  We will let you know the 
one in which you are presenting and your time slot.  Be sure you are ready at least 15 
minutes prior to the scheduled time for your your presentation.  Attendees can sit in the 

  



chairs in the audience to listen to the speaker.  The current presenter will be on the 
stage at the podium (1) and be able to share their screen.  Their audio and video will be 
broadcast to the whole room.    
 
When you scheduled to present, walk up onto the stage in the keynote room by using 
the arrows on your keyboard and stand on the orange circle.  Your audio and video will 
be broadcast to the entire room.  At the bottom of your screen, you will see the settings 
bar.  Click on the “share screen” button.  You will have the option of sharing your entire 
screen, or a specific application.  *There is sometimes a glitch where it looks like an 
endless loop when you initially share screen.  Note that once you choose your 
application, it should resolve itself.  
Tip:  When presenting, if you don’t want your shared screen to fill up the whole screen 
(in which case you won’t be able to see to whom you are talking), you can do the 
following: 

1. Go to the “Slide Show” menu 

2. Select “Set up Show” 
3. In the dialog box, click “Browsed by an individual” 

 
Asking questions  

You can text your questions directly to the presenter or to the moderator.  You can also 
wait until after the presentation to ask your questions.  Step up to the designated 
question space (2) between the aisles and ask your question.  Note that your audio and 
video feed will be broadcast to the entire room when you are standing here (so the 
audience can hear your question). Note to presenters:  
  
 

 

Poster Room  

There will be numbered boards associated with a corresponding poster (this will also be 
indicated in program).  Approaching the posters will show you a preview of the poster at 
the bottom of your screen.  If you would like to view the entire poster, press “x”.  This 
will make it full screen (although you will still see the video and audio of others in this 
private space).  Once you are finished with the poster, press “x” again to exit.  
Presenters will be with their posters and available to answer questions.  
  
*Note to poster presenters:  Stand near your poster (within the private space) so that 
people can find you and interact with you.  

Breakout Rooms  

There are breakout rooms (labelled 1 and 2) to the left of the main room.  These rooms 
can be used for discussions.  There are interactive whiteboards that can be used.    
  



The Lounge  
Located to the left of the main room, this room has multiple smaller private spaces.  This 
is a good area for private discussions or taking a break.   

Common issues and Solutions  

1. Gather.town is not working!  

a. You can try refreshing your browser.  

2. Audio/video do not seem to be working.  

a. If you are using a VPN, make sure to disable it.  

b. Make sure that your browser was granted access to gather.town.  

c. Check that your mic and camera are turned on by clicking on icons on the 

bottom right side of your page.  

  



Poster Presentations in Gather.town*  

The following lists the documents you are required to submit if you have been accepted for a poster 
presentation. There are also instructions on how to format these documents.  

Presenting in Gather.town  

All of the annual meeting will take place in Gather.town. There is a specific room where posters will be 
presented. You will need to submit your poster before the meeting, and it will then be set up in 
Gather.town for you. When your poster session is scheduled, you should stand in the shaded square in 
front of your poster. This shaded square is known as a “private space” and your audio/video will be 
shared with everyone else in this square, but not neighboring spaces.  

Submit all 3 required files:  

The following 3 items must be emailed to Dave Bergmann (dave.bergmann@bhsu.edu) by Friday, 
October 22. If you have any problems with formatting the required documents please do not hesitate to 
contact Dave for assistance.  

1. Title/abstractinPDFformat 
o Title/abstractforyourposter.(Youcanusetheoneyoualreadysubmittedoranupdated  

version, as you see fit.) This will be made available to all attendees beforehand so they can get a preview 
of your poster.  

2. PosterinJPGorPNGformat 
o This is what the participants will see when interacting with your poster presentation. See  

Figure 1 for an example. 
o Some image specifications. See instructions in next section on how to properly size images.  

o Maximumsize:3MB 
o Minimumwidth:1000px o Minimumheight:600px  

(*Credit for this set of directions goes to Carletom College)  



 

Figure 1: This is the view after interacting with a poster (by pressing x)  

3. PreviewinJPGorPNGformat 
o Submit the same image as in (2) but resized for a preview. Figure 2 illustrates poster  

previews seen while walking around the poster room.  

Figure2: Walking around poster room/ poster previews  

How to make posters/resize them  

For the main poster (file 2)  

1. We recommend using Powerpoint.  
2. Select the Design tab  
3. Select the Slide Size icon and choose Custom Slide Size from the dropdown menu  



 

4. Change width to 27cm and Height to 16cm.  
5. A pop-up will appear prompting you to make a selection. Choose Ensure Fit.  
6. File > Save. Name appropriately and save as JPG.  

For the poster preview (file 3)  

1. Repeat steps 1-3 from above.  
2. Change width to 13.5cm and Height to 8cm.  
3. A pop-up will appear prompting you to make a selection. Choose Ensure Fit.  
4. File > Save. Name appropriately and save as JPG.  
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